# CONTENTS

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>i</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINTER BASICS</td>
<td>1</td>
</tr>
<tr>
<td>Safety</td>
<td>1</td>
</tr>
<tr>
<td>Ink Cartridges and Printer Maintenance</td>
<td>1</td>
</tr>
<tr>
<td>Alignment System Setup</td>
<td>1</td>
</tr>
<tr>
<td>Part Identification, Location and Definition</td>
<td>2</td>
</tr>
<tr>
<td>Camera Assembly</td>
<td>2</td>
</tr>
<tr>
<td>Clearance Sensor (Obstruction Sensor)</td>
<td>2</td>
</tr>
<tr>
<td>Focal Ring</td>
<td>2</td>
</tr>
<tr>
<td>Media</td>
<td>2</td>
</tr>
<tr>
<td>Registration Marks</td>
<td>2</td>
</tr>
<tr>
<td>Set Screw</td>
<td>2</td>
</tr>
<tr>
<td>Platen Button</td>
<td>3</td>
</tr>
<tr>
<td>Power Switch</td>
<td>3</td>
</tr>
<tr>
<td>(Green) Print Button</td>
<td>3</td>
</tr>
<tr>
<td>(Red) Stop Button</td>
<td>3</td>
</tr>
<tr>
<td>USB Flash Drive Slot</td>
<td>3</td>
</tr>
<tr>
<td>Regulatory Information</td>
<td>4</td>
</tr>
<tr>
<td>United States</td>
<td>4</td>
</tr>
<tr>
<td>Canada</td>
<td>4</td>
</tr>
<tr>
<td>Europe</td>
<td>4</td>
</tr>
<tr>
<td>Japan</td>
<td>4</td>
</tr>
<tr>
<td>CALIBRATION</td>
<td>5</td>
</tr>
</tbody>
</table>
Platen Height........................................................................................................................................5
Camera Adjustment & Image Optimization.........................................................................................5
PRINTING........................................................................................................................................12
Treatment of Print Media..................................................................................................................12
Printing with Alignment Software ....................................................................................................12
Printing from Memory Cards or USB Drives......................................................................................19
Printing from Other Software...........................................................................................................19
Appendix A.......................................................................................................................................20
Image Editing.....................................................................................................................................20
Changing Units to Aid in Resizing an Image......................................................................................20
Copy and Paste..................................................................................................................................21
Flip Feature .........................................................................................................................................22
Cropping an Image..............................................................................................................................23
Image Editing Based on Media Snapshot........................................................................................24
Ink and Color Controls.......................................................................................................................24
Appendix B.......................................................................................................................................26
Frequently Asked Questions.............................................................................................................26
Appendix C.......................................................................................................................................29
Camera Adjustment Subsequent to Initial Install...........................................................................29
Appendix D.......................................................................................................................................30
Additional Menu Settings and Selections.........................................................................................30
File Menu Options..............................................................................................................................30
Platen Size Selection..........................................................................................................................30
Printer Settings Menu Option.............................................................................................................31
Print White Color...............................................................................................................................31
Camera Settings Menu Option ................................................................. 31
Summary of Default Settings at Install ..................................................... 33
PRINTER BASICS

Safety

The following types of safety notices may appear throughout the Quick Start Guide:

**WARNING**

WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or serious injuries.

**CAUTION**

CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injuries.

**IMPORTANT**

IMPORTANT information is provided for the convenience of the user and/or to assure continuation of the best possible function and output of the printer.

Common sense should be used when operating this or any other electrical apparatus. Do not take unnecessary risks with your health and safety or the health and safety of others.

Ink Cartridges and Printer Maintenance

Perform all ink and printer maintenance as indicated in the informational materials provided with these purchases.

Alignment System Setup

Refer to the system’s hardware and software installation documents for initial set-up instructions. If you have questions regarding basic printer settings or functions, error messages, etc., you can access manuals for the printer, view FAQ’s and troubleshooting information online at: http://brother-usa.com/ (click on the support button in the ribbon).
### Part Identification, Location and Definition

<table>
<thead>
<tr>
<th>Part Code</th>
<th>English Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.</td>
<td>Camera Assembly</td>
<td>The <strong>camera assembly</strong> consists of the camera, the USB 3.0 cable, the camera mount (pole) and all connecting brackets (including the camera housing, shown). Only the uppermost portion of the camera assembly is pictured above.</td>
</tr>
<tr>
<td>B.</td>
<td>Clearance Sensor (Obstruction Sensor)</td>
<td>The <strong>clearance sensor</strong> refers to the thin strip across the printer opening at the top of the platen path, which keeps the platen from entering the printer when the platen is not set low enough or some portion of the <strong>media</strong> projects up too high. It prevents damage to the printhead.</td>
</tr>
<tr>
<td>C.</td>
<td>Focal Ring</td>
<td>The <strong>focal ring</strong> is a ring around the lens of the camera. Twisting the <strong>focal ring</strong> moves the lens to bring the image in (sharp) and out (blurry) of focus.</td>
</tr>
<tr>
<td>D.</td>
<td>Media</td>
<td>Unless otherwise indicated, <strong>media</strong> refers to the material to be printed on: fabric, leather, wood, embroidery, etc.</td>
</tr>
<tr>
<td>E.</td>
<td>Registration Marks</td>
<td>The <strong>registration marks</strong> allow the software to “find” the <strong>media</strong> in relation to the print area. These are sometimes called targets.</td>
</tr>
<tr>
<td>F.</td>
<td>Set Screw</td>
<td>The <strong>set screw</strong> keeps the camera view stable by clamping the camera housing to the mounting pole.</td>
</tr>
<tr>
<td>Part Code</td>
<td>English Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>G.</td>
<td>Platen Button</td>
<td>The <em>platen button</em> either retracts the platen into the printer or ejects the platen out of the printer depending on its position when the button is pressed. This button is used to verify that media affixed to the platen (or jigs) is positioned low enough to prevent a print head strike.</td>
</tr>
<tr>
<td>H.</td>
<td>Power Switch</td>
<td>The <em>power switch</em> turns the printer on and off.</td>
</tr>
<tr>
<td>J.</td>
<td>(Green) Print Button</td>
<td>The green <em>print button</em> lights in response to a print command sent from the computer. The button flashes while receiving data and becomes solid when the information is complete. Then a chime signals that the data is ready to print.</td>
</tr>
<tr>
<td>K.</td>
<td>(Red) Stop Button</td>
<td>The <em>stop button</em> is used to halt any of the printer’s processes. It cancels printing or print head cleaning and returns the printer to standby mode.</td>
</tr>
<tr>
<td>L.</td>
<td>USB Flash Drive Slot</td>
<td>The <em>USB port</em> allows you to plug in a portable hard drive—sometimes called a jump, thumb or flash drive—in order to upload AR3 files directly to the printer.</td>
</tr>
</tbody>
</table>
Regulatory Information

United States

FCC Warning

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Canada

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

Europe

ATTENTION

This is a Class B product. In a domestic environment, this product might cause radio interference, and the user might be required to take corrective measures.

The standards compliance label on this device contains the CE mark which indicates that this system conforms to the provisions of the following European Council directives, laws, and standards:

- Low Voltage Directive (LVD) 2006/95/EC
- EN50082-2/EN55024:1998 (European Immunity Requirements)

Japan

VCCI-B

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。

取扱説明書に従って正しい取り扱いをして下さい。
CALIBRATION

Platen Height

During the calibration process, you will want the printing surface to be the same height as the print surface of your post-calibration media. For the sharpest printed image, adjust the platen so that the height of the print surface is the maximum allowed by the clearance sensor bar. For instructions on how to raise and lower the platen, refer to the materials that came with your printer.

**TIP 1:** When printing on a ready-made item it is possible that seams, buttons, etc. will rise above the area on which you want to print. In order to pass the clearance sensor and still position the print area at the optimum print height, you will need to make the area to be printed the highest point. You can do this by inserting chipboard or cardboard into the garment under the area to be printed to create a high, level surface, then adjust the platen height as you would normally.

![Image of jeans with chipboard inserted](image)

Camera Adjustment & Image Optimization

The camera should be calibrated to the printer before its first use. Subsequent calibrations are unnecessary unless the camera has been moved or attached to a new printer, or when alignment accuracy has degraded.

Camera calibration is done through the alignment software. If possible, use the 14” x 16” platen during calibration (this will not limit your future printing options to the 14” x 16” platen).

1. Begin by trimming a piece of heavy white cardstock to the size of your platen.

   We use Canson’s 140lb cold press watercolor paper, but other materials may work well, too.
**IMPORTANT**

Thin cardstock or paper will warp or curl as it absorbs moisture from the inks. Because these imperfections will produce errors in the calibration, avoid using thin cardstock or paper.

---

2 Put double-sided or rolled office tape on the corners of the cardstock and flip the cardstock tape-side down. Smooth the cardstock over the platen, making sure it is attached securely and that it is lying flat, not bowed in the center.

---

**Did you know...**

…it is possible to use a white t-shirt for calibration instead of the heavy cardstock. However, it is imperative that the printed grid have straight, hard edges, therefore the shirt used must be smooth and flat and treated to prevent bleeding of the ink. Printing twice (by pressing the Green Button after the first print) may improve the contrast, and therefore the focus, for calibration.

---

3 Verify that the platen will slide under the clearance sensor bar and that it is the optimum distance from the printhead (see **Platen Height** above).

---

If the alignment software isn’t already open, double-click the desktop icon or browse to the program in the Windows menu to launch it.
5. A window will open similar to the one at left.

6. Select Camera Settings from the Options menu. Choose See3CAM_CU130 in the drop-down box then press the OK button.

7. Select Calibrate Printer from the Setup menu.

8. A window like the one at left will appear. Click on the “Open Pointing Tool” button.
Another window will open letting you look through the camera’s eye. If necessary, manually adjust the camera (Appendix C) so that it “sees” the entire printing area covered by your cardstock as well as the 2 registration marks (circled) on either side. The green crosshairs need not be in the center of the platen.

When the camera is in the correct position, click the Next button in the Printer Calibration window to advance to the screen shown at left.

If you’ve already attached your cardstock (steps 1-2 above), press the Calibration Print button.

Click the OK button in the window shown at left and press the green button on the printer when the printer chime indicates that all data has been loaded (this may take a few minutes).
When the calibration pattern has been printed, the Next button in the Printer Calibration window will become active. Press the Next button to advance to the next screen and then press the Open Focusing Tool button (shown below).

If you cannot see your computer screen while standing next to the camera, you will need a helper for the following step.

When the Camera Focus Helper window opens, manually adjust the focal ring of the camera (by twisting) to make the view of the calibration pattern as sharp as possible, then press the Close button. Note that the best overall focus will be achieved when the Contrast Level number in the lower left corner of this window, is as high as you can make it.

Refer to solutions in the FAQ section, if the platen is not visible in your Camera Focus Helper window.
14 Once you have focused the camera, press the Next button.

In the screen that follows, press the Calibration Capture button.

15 While the software is processing the camera data a progress bar appears and several buttons become inactive.

Note that the progress bar will not show the action as complete until the registration marks have been identified (see steps 16 and 17, below).

16 The Image Object Picker window will open and you must check the 2 boxes next to the clearest, complete test images of the registration marks. You may view the images by clicking on their name.
17 When you have selected 2 images the Select button will become active.

If there are not 2 good images, follow the procedures outlined in the FAQ section.

Press the Select button to accept your choices and resume the Calibration Capture process.

18 When the scan has been completely processed, the window at left will appear. Press the OK button.

The camera is now calibrated to the printer.

19 Press the Finish button in the Printer Calibration window.

You may remove the cardstock from the platen and save (the blank back may be used for a future calibration), scrap or recycle it.

The alignment system is now ready for use with the platen or jig of your choice.
PRINTING

Treatment of Print Media

The use of chemical or heat treatment of media before or after printing should be addressed in the materials that came with the printer or the inks. When using chemical treatments, follow the manufacturer’s instructions regarding storage, use and safety.

Printing with Alignment Software

1. To start the alignment software, double-click the desktop icon or browse the Windows menu, navigating to the program to launch it.

2. A window will open similar to the one at left.

3. If this is a new session, Select Camera Settings from the Options menu. Choose See3CAM_CU130 in the drop-down box then press the OK button.

(Repeated selection of the Camera Device is a known issue and will be addressed in future versions of the software.)
4. Make sure the proper platen size and printer have been selected thru the menu bar.

5. If the printer has not been calibrated, perform calibration as described in a previous section.

6. Position your media on the platen. Adjust the platen height (refer to printer manual for instructions) so that the media’s print surface is as high as it can be without striking the clearance sensor bar. Verify height using the platen button.

**TIP 2:** You can use temporary markers, such as flags or sticky notes, with the alignment software to aid with sizing or placement. Simply place them on top of your media. Take your snapshot as usual, then remove the flags/stickies before printing, being very careful not to move the media. Do not use fabric pens as these may interact with treatment liquids, becoming permanent.
7 With the platen back out in the load position, press the Take Snapshot button in the upper left of the AS300 window.

8 While the camera is working, a progress bar will be visible on your screen.

9 An Image Object Picker window will appear. As with calibration, printing requires that you check the boxes next to the clearest, completest shots of the registration marks.

10 Press the Select button in the Image Object Picker window to allow the software to complete the image capture process.

The Black Level slider at the left may be adjusted at any time after the snapshot has been processed, to help improve your visibility (within the software) of the media on the platen.

11 Next press the Select Image button.
Note that logos taken from email signatures or images captured from older telephone cameras or from the web are generally low resolution and will appear “pixelated” or “grainy” if they are enlarged. The software cannot manufacture, nor the printer print, a level of detail that was not saved in the original image. Also, large file size is not always an indicator of high image resolution.

12 Browse to the drive and folder containing your image, select it, and press the Open button in the lower right.

The software can use JPEG, PNG, TIFF and Bitmap files, even though the browser defaults to JPEG.

To “see” available files that are not JPEGs, select All Files (*.*) from the dropdown at the lower right.

13 Use the buttons, sliders and text boxes in your control panel, or your mouse and the image handles in the Alignment View, to resize, rotate and position your image.

These tools may be used repeatedly and in any order.

Note that the image handles or “grips” used to resize an image are not visible until the image is smaller than the print area.

Did you know...

...your control panel?

The Black Level slider to the left of the snapshot increases or decreases the contrast of the snapshot to help the user see details—especially helpful when used with white media.
The Trans slider to the left of the image affects the transparency of the image within the Alignment View, though it does NOT affect the saturation of the print.

The Height and Width text boxes may be used to shrink or enlarge the image proportionately, if the Retain Aspect Ratio box is checked, or disproportionately—stretching or squashing the image—if the Retain Aspect Ratio box is unchecked. The arrows next to these text boxes change the height or width by one unit. If these intervals are too big / small, either go to the View tab and change the units to something smaller/bigger or, if applicable, highlight the text and enter the desired decimal number. You may also resize the image in the Alignment View using the grips (the white boxes along the edges of the image). The Reset Scaling button will return the image or portion of the image (the button does NOT un-crop an image) to its original dimensions.

Use the Up, Down, Left and Right buttons to move the image in the Alignment View. The size of the “step” is dependent upon the Zoom slider: if you are zoomed out to see the whole mat the steps are large, if you are zoomed in to see a very small area, the steps are very small. You may move the image in the Alignment View by the drag-and-drop method using the left mouse button.

The Rotation text boxes are used to rotate the image in whole degrees or tenths of a degree through the range of -180 degrees to 180 degrees. A negative value results in a counter-clockwise rotation. You may also rotate the image in the Alignment View with the mouse by left-clicking on the green handle appearing in the center of the active image.

The Undo and Redo buttons allow you step backward and forward through the sequence of alterations that have been made to image size, cropping, rotation and placement.

The buttons and boxes above affect the active image (indicated by the presence of the handle and grips). To switch between images, left-click on the image in the Alignment View that you want to work with.

The Print button initiates the printing process detailed elsewhere.

Clear All deletes the snapshot and all images in the Alignment View to reset the session.

The Zoom slider on the far right allows you to zoom in the Alignment View to see more detail. It does not crop the printed image (look at the Edit menu in the toolbar to crop or mirror the image).

Image editing features such as copying and cropping are discussed in the Appendix.
Continue adjustments until you are satisfied with the size and placement of the image.

Did you know…

...that, while the Up, Down, Left and Right buttons always move the image in the corresponding direction within the Alignment View, the Height and Width always affect the height and width, respectively, of the original image? For example, if you have already rotated the image 90 degrees in the Alignment View and you want to stretch your image in the top-to-bottom direction (of the View) to better fit your media, you would be stretching the width of the image and would therefore adjust the Width in the text boxes (or use the appropriate grips).

At this time, you may copy and paste the selected image to use it again (see Appendix A), select an additional image to work with (pictured at left) or print.

Note the grips are only visible on the one image that is currently being manipulated.
16 When you are satisfied with the position of the images you are ready to print. Make sure any flags or sticky notes have been removed from the media and press the PRINT button in the AS300 window.

17 Press OK, when the window shown at left appears on your screen.

Depending on your setup and the complexity of your image(s), expect a 1-2 minute delay between the software’s print command and the printer’s indication that it is receiving data.

18 While the printer is receiving data, the green button on the printer will flash. When the printer chimes, data transfer is complete and the green button should remain lit.

Press the green button to begin printing.
The platen will eject when printing is complete. If you are not done with the piece(s), you may delete the existing images in the Alignment View and choose another image, continuing work (from step 13 above) with the original media & media snapshot. Otherwise, remove the finished piece(s) from the platen.

Allow the ink to dry (times will vary based on the absorbency of the media) or heat treat finished piece(s) as directed by the manufacturer of any pretreatment chemicals used.

To begin a new session, press the Clear All button to clear the snapshot and your working images; then confirm your choice in the window at left.

Printing from Memory Cards or USB Drives

Images for printing can be taken from a USB drive plugged into the PC, but must be selected through the AS300 software in order to take advantage of the alignment system.

Printing from Other Software

To print from other software, follow the directions provided with your GT printer or the specific software you wish to use. The alignment system cannot be used with any other software at this time.
Appendix A

Image Editing

Changing Units to Aid in Resizing an Image
The image can be viewed in pixels, inches, meters, centimeters, millimeters, and percentages of the original.

If you are already working in the desired units and you know the dimensions of your media you may highlight the numbers and type in these dimensions, unclicking the Retain Aspect Ratio box if applicable.

If you need to resize the image to match an unknown media size, you can use the arrows to the right of the text boxes or you can type in values as above. (When using the arrow keys, the numbers are adjusted by unit, so if the units are inches, the up arrow will increase the value by one inch.)

However, if you don’t want to find the size by trial and error, but the arrow “steps” are too large go to the view tab in the menu and change the units to something smaller, such as millimeters or percentages.

Likewise, if the steps are too small, switch to a larger unit, like inches or centimeters.
Copy and Paste
The selected image can be copied and pasted using Ctrl-C and Ctrl-V or by selecting Copy then Paste from the Edit tab in the menu bar. It may be deleted using the menu command or the Delete button on your keyboard.

The pasted image will appear directly on top of the original and must then be moved to your desired location.

To switch between images, simply click on the image you want to move, resize, edit or delete.

Commands will only affect the selected image.

A second, different image may be added to the Alignment View by left-clicking off all existing images to deselect them and then pressing the Select Image button to browse to another file.
Flip Feature
At times you may want to use the mirror image of the selected image file, either to better fit the media or to create a “bookend” of the original image.

You can mirror the selected image using Flip Horizontal under the Edit tab in the menu bar.

Regardless of the rotation or placement of the image in the Alignment View, the Flip feature will mirror the image horizontally based on the orientation of the original image.

If the selected image is a copy of the original, the copy only will be flipped.

Flipping an image twice will essentially undo the first flip.

If you want your image flipped vertically, you must use a combination of a horizontal flip + a 180° rotation to achieve that effect.
Cropping an Image

A selected image can be cropped using the Crop function accessed through the Edit tab on the menu bar.

Choosing Crop from the menu will open a window like the one at the left. The crop box can be moved by dragging the black lines to the desired position or by highlighting the text in the coordinate text boxes at the upper left and lower right and manually entering new numbers.

X-values change the top & bottom and Y-values affect the sides.

To accept the crop, press the OK button and you will return to the Alignment View with the selected image cropped as desired.

Note: neither the Reset Scaling button, nor the Reset Scaling menu option will restore the portion of an image that has been cropped. This must be done through the Crop option (using it to un-crop) or by reloading the original image.
Image Editing Based on Media Snapshot

The user is able to tailor images to their media in more sophisticated ways with the aid of the Save Snapshot feature. Save Snapshot allows you to save the snapshot of the media on the platen as an image file that can then be imported into powerful image editing programs, such as Adobe PhotoShop, for use as a template. The desired images can then be digitally masked to better fit the media.

Ink and Color Controls

Various ink and color controls are located in the Print Settings window.

These controls affect the appearance of the printed image and not the image as viewed on screen. They are similar in function to those incorporated in Brother’s PDIP software. Specifics of their use are located in Chapter 4 of the GT-3 Series Instruction Manual, which is available for download from the Brother website.

Briefly...

- Resolution affects the droplet size of the ink. Higher dpi = more detail and longer print times.
- Highlight affects the amount of white in the light areas of the image.
- Mask affects the amount of white used as a primer under the dark areas of an image.
- Choke Width affects the offset or margin between the white undercoat and the colored image layer. If the white layer shows as a halo around your image, increase the choke width. Keep in mind that very small elements or text (like registration marks) will not be printed if the choke is increased.
- White / Color Pause provides additional drying time before the highlight and color is applied to the media by the printer. Use this feature when the white undercoat is supersaturated.
- Saturation increases the color brightness of the image. This option is useful when an image was originally created in CMYK color mode and the colors appear dull on screen. Images with higher saturation may have brighter colors and bolder text, but usually at the expense of subtle details.
- Contrast affects the light and dark areas of an image. Increasing contrast makes dull and plain artwork “pop” because it makes the lighter areas brighter and the darker areas darker.
- Uni-Directional Printing is used when the platen has to be lowered to print on thick or uneven surfaces, such as a woven placemat or the area next to a zipper. If Tip #1 cannot be used for such materials, the platen must be lowered enough to avoid damage to the printhead caused by contact with any part of the media; however, lowering the platen also lowers the desired print surface. Since the highest point of the media would then be positioned at the optimum distance from the printhead, and all or a portion of the desired print area would be further away from the printhead, normal bi-directional printing will produce a very minute offset between from-the-right printing and from-the-left printing causing the printed image to look blurry. Uni-Directional Printing will increase print times, but will prevent the double image effect, resulting in a sharp looking print.
Appendix B
Frequently Asked Questions

What do I do if the 3 meter USB 3.0 cable provided is not long enough?

Always use the provided USB 3.0 cable to plug into the camera. If more length is needed, connect a second USB 3.0 cable (no longer than 3 meters) to the provided cable using a powered USB 3.0 hub between the two.

When do I need to perform a calibration?

A calibration print and scan should be performed whenever the camera has been moved, when alignment accuracy has degraded, or when Take Snapshot produces an (unexpected) black rectangle in the Alignment View and Snapshot thumbnail.

What do I do if the Camera Focus Helper window does not show me a view of the platen?

If a popup similar to the one at right appears, press the Continue button. Repeat as needed.

If a window similar to this one appears, close the Camera Focus Helper window by clicking the red “X” in the top right corner, then press the Open Focusing Tool button (in the Printer Calibration window) again. Repeat as needed until you are shown a view of the checkerboard on the platen. Return to step for focus adjustment within the calibration instructions and proceed normally.

These are known issues and will be corrected in a future version.
When calibrating or printing, what do I do if there are not two good images of the registration marks?

First, check that there is nothing obstructing the camera’s view of the registration marks, click the Cancel button and re-capture the image. If this second try does not produce good images of both targets, improve the lighting of the platen and targets, click the Cancel button and re-capture the image.

If you still do not see good images of both registration marks, it is possible that the camera has been moved so that one or both of the registration marks are in its “blind spot”. In this case, you will have to manually adjust the camera position, then re-calibrate the camera to the printer.

What do I do when Take Snapshot is not showing an accurate picture of the item(s) on my platen?

If the Take Snapshot button shows an unexpected black rectangle in the Snapshot thumbnail and Alignment View (as shown below), the camera needs to be recalibrated. If the Snapshot thumbnail is correct, but the media is cut off in the Alignment View, either some portion of the media falls outside the platen’s printable area or the incorrect platen size has been selected. Platen size selection is located under the Options menu.
What size platen do I select in the software if I am using the sleeve platen to print?

You must select the 16”x18” platen from the Platen Size or Print Settings menu in order for the software to “see” the entire length of the sleeve. Note that the print area displayed in the software will correspond to the 16”x18” platen NOT the sleeve platen, and will therefore allow you to position images to print off the edge of the sleeve. To prevent the mess of off-edge printing, the user must either size, position or crop the image to fit within the sleeve area, as shown by the snapshot, or they must mask the area under and surrounding the sleeve platen.

Why did my arrow keys stop working?

If the zoom slider is selected (indicated by blue color), the arrow keys will act on the zoom rather than the image position. Click on the image to deselect the slider and the arrow keys will once again affect the movement of the image: up, down, left or right.

Why is there no response from printer when trying to print?

There is a delay of approximately 1 minute between the software’s print command and the printer’s flashing green light signaling incoming data. If the light is not flashing after 2 or 3 minutes check the software’s menu bar to make sure the correct printer has been selected. To recover, select the correct printer and try the print again.

Why did my image print in black and white when I selected a color print for a color image?

If the software is closed while the image data is still spooling to the printer, the printer may abort the job or, if processed, the outcome of the print may be unexpected.
Appendix C
Camera Adjustment Subsequent to Initial Install

If the camera is knocked out of alignment recalibration will be required.

First ascertain that the camera housing and other mounting brackets have not been damaged. Then complete steps 1 through 8 of the calibration sequence. In step 9, if the entire platen or either registration mark does not appear in the CameraPointingTool window, manual adjustment of the camera will be necessary as detailed below.

To adjust the camera, you will need a 2.5mm hex key or Allen wrench (not provided).

Use the hex key to loosen the set screw at the back of the camera housing.

Rotate the camera housing around the mounting pole until the entire platen and both registration marks (targets) are visible in the CameraPointingTool window.

Tighten the set screw, make sure the USB 3.0 cable is still firmly attached, and proceed with the remaining steps of calibration.
Appendix D
Additional Menu Settings and Selections

File Menu Options

Take Snapshot
Captures camera data of any media on the platen. This menu option produces the same result as pressing the Take Snapshot button in the main window.

Save Snapshot
Saves the current media snapshot in one of several image formats, for use outside the alignment software. When imported into image editing software, such as Adobe Photoshop, the saved snapshot allows the user to tailor their image(s) to fit the desired media. For example, a snapshot of tennis shoes, might allow to the user to erase grommeted areas from the desired image—rather than masking the grommets on the shoes on the platen—before printing. Save Snapshot is not active in the menu until a snapshot has been taken.

Select Image
Opens Windows Explorer, allowing the user to browse for the desired image to print. This menu option produces the same result as pressing the Select Image button in the main window.

Print
Sends image data to the printer. This menu option produces the same result as pressing the Print button in the main window. It is not an active option until at least one image has been selected.

Exit
Closes the alignment software. This menu option produces the same result as pressing the red “X” in the upper right of the main window.

Platen Size Selection
Select your platen from the Options Menu through the Platen Size dropdown. This will change the platen size for all operations throughout the software.
Printer Settings Menu Option
The software uses the GT-381 model printer by default. If necessary, change the printer by selecting Printer Settings from the Options Menu then choosing your printer model from the Machine Mode dropdown.

PDIP Functions
The ink and color controls that you may be familiar with from Brother’s PDIP software, are also located in the Print Settings window. The functionality of these controls is discussed at length in Chapter 4 of the GT-3 Series Instruction Manual; therefore, only a brief description is included in this document (with the image editing text in Appendix A). The GT-3 Manual is available for download from the Brother website.

Print White Color
Many images have a white (color = 255) background. If the Print White Color option is checked, the white background will print. If unchecked, the white background and any other white pixels in the image will not print. This will reduce ink usage, but may not be desirable if the media is not white. Print White Color is synonymous with the PDIP function 255 > 254.

Camera Settings Menu Option
Camera Selection
To select the camera, first choose Camera Settings from the Options Menu, then select the See3CAM_CU130 from the Select Camera Device dropdown. When it becomes active, press the OK button to accept your selection. You might need to select the camera each time you open a new session of the software—this is a known issue and will be addressed in future versions of the software.
Flash Control
This feature is used for diagnostics only. Changing the flash control from the default setting may render the unit inoperable/cause unexpected results.

The default flash control setting is “on”.

Camera Control: Exposure
This feature is used for diagnostics only. Changing the exposure from the default setting may render the unit inoperable/cause unexpected results.

The default exposure setting has the “Auto” box checked.

Lens: Focal Length
This feature is used for diagnostics only. Changing the focal length from the default setting may render the unit inoperable/cause unexpected results.

The default focal length setting is 7.400.
Summary of Default Settings at Install

View (units) inches

Options

Platen Size 14” x 16”

Print Settings

Machine Mode GT-381
Job Comment none
Platen Size 14 x 16
Resolution 1200 dpi x 1200 dpi

<table>
<thead>
<tr>
<th>Ink</th>
<th>Color + White</th>
<th>White Only</th>
<th>Color Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Volume (Color Settings)</td>
<td>-----</td>
<td>-----</td>
<td>10</td>
</tr>
<tr>
<td>Highlight (White Settings)</td>
<td>5</td>
<td>5</td>
<td>-----</td>
</tr>
<tr>
<td>Mask (White Settings)</td>
<td>3</td>
<td>3</td>
<td>-----</td>
</tr>
<tr>
<td>Print Time</td>
<td>-----</td>
<td>3</td>
<td>-----</td>
</tr>
<tr>
<td>Whiteness</td>
<td>-----</td>
<td>533</td>
<td>-----</td>
</tr>
<tr>
<td>Print with Black Ink</td>
<td>checked</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Color Multiple Pass Printing</td>
<td>-----</td>
<td>-----</td>
<td>unchecked</td>
</tr>
<tr>
<td>Transparent Color</td>
<td>unchecked</td>
<td>unchecked</td>
<td>-----</td>
</tr>
<tr>
<td>Choke Width</td>
<td>2</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>White / Color Pause</td>
<td>unchecked</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Saturation</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Contrast</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Uni-Directional Printing</td>
<td>unchecked</td>
<td>unchecked</td>
<td>unchecked</td>
</tr>
<tr>
<td>Number of prints</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Camera Settings

Flash Control On
Camera Device none
Camera Control: Exposure Auto checked
Lens: Focal Length 7.400

Generally, the default print settings are favorable to printing on white t-shirts.

Note: Changes to these settings will be saved when the user exits the program. When the program is re-opened, the user’s most recent settings will be loaded.